
Introduction to DateTime File Stamp 

· Primary purpose of the DateTime File Stamp program is to stamp a collection of files with
identical date and time before the files are distributed.    For example, a software 
developer may wish to stamp all files in a finished application, or just the newly created 
and modified files in an upgraded version of the application.

· A unique feature of the DateTime File Stamp program is the capability to modify the 
creation time of folders.      

· The DateTime File Stamp program is also able to delete selected folders, including any 
files or subfolders, and to completely wipe out selected files.

· The program user interface features an Explorer-like folder tree and file list to help you 
navigate through the file system and select multiple files and folders for stamping or 
destruction.    The desired date and time is set by a bank of individual spin-buttons for 
month, day, year, hour, and minute or entered from keyboard in a variety of formats.    
The date can be anything between the beginning of the year 1970 and the end of the 
year 2037.
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Date/Time Stamp

· On program start-up, the Date/Time Stamp edit control displays either the current 
system date and time or the last date and time used for stamping folders and files, 
depending on the check mark made in the previous session in the Time tab of the 
Options dialog box.    The date and time is rounded to the nearest minute, hour, day, or 
month,    depending on the minimum time step selected in the previous session by the 
Options menu command.    You can subsequently turn on a different date and time using 
the appropriate spin-buttons for month, day, year, hour, and minute.    The displayed 
date and time is used by the Make_Stamp menu command to change the creation time 
of folders and the last modification time of files selected in the main window File_List 
control.

· Keyboard control of the spin-buttons enables you to change the month, day, year, hour, 
or minute in steps larger than one.    After giving the input focus to the appropriate spin-
button, either with the <Tab> key or clicking it with the mouse, use the <Up> and 
<Down> arrow keys to increment or decrement the corresponding element of the date 
and time display by one, just like clicking the spin-button with the mouse.    Use the 
<PgUp> and <PgDn> keys to increment the month indicator by 6 month, the day 
indicator by 7 days, the year indicator by 10 years, the hour indicator by 12 hours, and 
the minute indicator by 10 minutes.

· Alternately, you can enter the date and time from the keyboard and press the <Enter> 
key.    The two required fields are the month and the day of month.    If these two fields 
are not provided, the date and time do not change.    Other fields, such as the year, hour,
minute, and the AM/PM string are optional.    If some of these fields are not entered, the 
current values are used.    The month can be either a number between 1 and 12 or a 3-
letter abbreviation of the month name in English.    The year can be in either 4 or 2 digit 
format.    Individual fields (except AM/PM) must be separated by a space, tab, slash, 
backslash, hyphen, underscore, period, comma, colon, semicolon, or any combination 
thereof.    The trailing AM/PM string does not have to be separated.    Examples are "3/10",
"3.10.1995", "3-10-95 11pm", "mar 10, 1995, 23:30", etc.    If you wish, for example, to 
keep the current date and only adjust the time, erase and re-enter just the hour, minute, 
and optionally the AM/PM string.    You can enter the time in either 12- or 24-hour format, 
regardless of the current time format selected in the Time tab of the Options dialog box. 

· You can turn on (using the spin-buttons) or enter (using the keyboard) any date and time 
between January 01, 1970, 00:00 until January 19, 2038, 03:14 of Greenwich Mean Time 
(GMT).    In western hemisphere, both limits shift up to -12 hours, depending on your time
zone.    In eastern hemisphere, the lower limit shifts up to +12 hours, but the upper limit 
remains the same as the GMT upper limit.    Time zones in eastern hemisphere, which are
located south of the equator and which use daylight savings (some Australian and New 
Zealand time zones), have their lower limits increased by additional +72 hours (+3 days)
and their upper limits decreased by additional -72 hours (-3 days).    These limits are due 
to the operating system and programming language limitations.    Anything outside of 
these limits is ignored and will not affect or change the displayed date and time.

· Time is automatically adjusted for daylight saving according to the rules of the present 
time zone    set by the Time_Zone command or by the Windows 95/98 Date/Time 
Properties.    In all U.S. time zones, the daylight saving is in effect from 2:00AM standard 



time of the first Sunday in April until 2:00AM standard time of the last Sunday in October. 
Other time zones may have different rules (particulary those used in southern 
hemisphere) or no daylight saving at all.    The rules are shown in the Time_Zone dialog 
box.



Folder Tree
 
· The Folder Tree combo control, called "Look in" on the main window, displays the name 

of the current open folder.    The drop-down list contains the names of all drives, 
removable, fixed, and network.    It also shows the folder path from the root directory on 
the current drive up to the current open folder and its sub-folders (if any).    If the 
appropriate option is checked in the dialog box of the Options menu command, these 
sub-folders are listed in the main window File_List control as well.

· You can use the drop-down list of the Folder Tree combo control to move one level down 
or several levels up in the folder tree on the current drive, or you can select another 
drive.    Any time you change the current open folder, both the Folder Tree and File_List 
controls are reset and refilled.



Sort Buttons

· Three Sort Buttons, called <Modified>, <Name>, and <Type>, are located right above    
the main window File_List control.    You can use the <Modified> button to sort the folders
by the creation time and files by the last modification time.    The <Name> button sorts 
the folders and files alphabetically by name and the <Type> button sorts files 
alphabetically by type, i.e., by the file extension.    Folders are sorted separately from 
files and always remain on top of the files in the main window File_List control.

· Each of the three Sort Buttons updates only the sorting order of the main window 
File_List  control.    If any folders or files were created, copied, moved, renamed, or 
deleted since the last refill of the control, these changes are not reflected until the 
File_List control is refilled again.    The one notable exception to this behavior is an 
automatic refill of the File_List control when one of the Sort Buttons is used right after 
typing in a user defined file type into the edit-line of the main window File_Types combo 
control.

· The fourth button left to the three Sort Buttons, with a little folder image and an up 
arrow, is not a sort button at all.    You can use this button to move one level up in the 
folder tree without opening the drop-down list of the main window Folder_Tree combo 
control. The File_List is scrolled down to show the previous folder on top.



File List

· The File List control contains a list of sub-folders and files, together with their dates and 
times, of the current open folder.    The control is automatically reset and refilled every 
time you open a new folder by moving up or down the folder tree, when you pick a new 
file type from the drop-down list of the main window File_Types combo control, and also 
when you change any file option in the dialog box of the Options menu command.

· Changing the time format in the dialog box of the Options menu command only updates 
the File List control.    If any folders or files were created, copied, moved, renamed, or 
deleted since the last refill, these changes are not reflected until the File List control is 
refilled again.    Sort_Buttons have similar effects, in addition to performing the specified 
folder and file sort.    The one notable exception to this behavior is an automatic refill of 
the File List control when a sorting button is used right after typing in a user defined file 
type into the edit-line of the main window File_Types combo control.

· Multiple folders and files can be selected in the File List control.    To select or unselect a 
folder or file, click it with the mouse.    Alternately, give the list item an input focus using 
the <Up> and <Down> arrow keys and then press the <Space> key.    With the 
exception of files currently in use by other applications, all selected files will have their 
last modification time changed to the date and time shown on the main window 
Date/Time_Stamp display when executing the Make_Stamp menu command.    The 
command will also change the creation time of all selected folders, unless some files in 
the folders or their subfolders are in use.    If you include any such folders in your 
selection and then execute the Make_Stamp menu command, you will receive error 
messages, one for each selected folder with files in use, as the command steps through 
the list.    Use the Select_All_Folders menu command for a quick selection of all folders 
listed in the File List control.    Use the Select_All_Files menu command for a of quick 
selection of all files.

· Double clicking on a folder listed in the File List control moves you down one level in the 
folder tree and opens the clicked folder.    Double clicking on an executable file starts the 
application.    Double clicking on a document file, i.e., on a file associated with another 
application, starts that application and loads the clicked file.    Giving focus to a folder or 
file and then pressing the <Enter> key has the same effect.    Please note that giving 
focus is different from highlighting.    Focus is indicated by a dashed border rectangle 
around the folder or file.

· You can drag folders and files from the Windows Explorer and drop them into the File list 
control.    Depending on whether or not you hold down the <Ctrl> key when you start this
operation, the dropped folders and files are either moved or copied into the present open
folder.    However, folders and files can be moved only within the same physical disk 
(even for a network drive mapped twice under under two different local drive letters).    If 
you try to move folders or files from one disk to another, the operation defaults to 
copying, regardless of the status of the <Ctrl> key.    If a file with the same name already 
exists in the present open folder, you have an option to overwrite it.    If a subfolder with 
the same names already exists in the present open folder, the drag and drop operation 
fails.    In addition, it is not possible to move or copy a folder unto itself or into one of its 
own subfolders.



File Types

· The list of available file types is reset and refilled every time you open a new folder by 
moving up or down the folder tree.    The file types include all file extensions found in the 
current open folder, plus the "All files (*.*)" type.    Although the DateTime File Stamp 
supports long file types, if the particular long file type is associated with more than one 
file extension, all these extensions are listed.    For example, both "Intermediate file 
(*.obj)" and "Intermediate file (*.res)" would be listed.    The main window File_List control
is automatically reset and refilled upon selecting a new file type from the drop-down list 
of available file types.

· In addition to the predefined file types, you can specify any other file type, with the help 
of wildcards, by typing it in.    When finished typing, please update the main window 
File_List control by pressing the <Enter> key or one of the Sort_Buttons.



Maximize Box

· The Minimize and Restore boxes of the DateTime File Stamp program respond in exactly 
the same way as in other Windows applications.

· The Maximize box of the DateTime File Stamp program exhibits slightly different behavior
from other Windows applications.    When maximizing the DateTime File Stamp 
Main_Window, the width remains the same.    Only height of the window is increased to fit
the display, minus the hight of the Windows taskbar (if the taskbar is located at the 
either top or bottom screen edges, always on top of other application windows, and not 
in an auto-hide state - see the Windows Start menu, Settings ® Taskbar command).    
Height of the File_List control is increased as well, in order to fit the increased main 
window height, and make browsing of large file folders easier.    Drop-down box heights of
the Folder_Tree and File_Types controls are also appropriately increased for the same 
purpose.    Restoring the main window size using the Restore box or the System menu 
Restore command also restores the original heights of all controls.

· Double clicking the DateTime File Stamp caption bar with the left mouse button has the 
same effect as clicking the Maximize or Restore boxes, just like in other Windows 
applications.



Make Stamp

· Use the Make Stamp command to actually change the creation time of folders and the 
last modification time of files selected in the main window File_List control to the date 
and time turned on the Date/Time_Stamp display by the year, month, day, hour, and 
minute spin-buttons.

· The Date/Time used for stamping is saved at the bottom of the Stamps menu, unless an 
identical Date/Time stamp already exists on the menu.    Stamps saved on the menu can 
be used again later on, without typing the date and time into the Date/Time_Stamp edit 
control or setting them with the help of the corresponding spin-buttons.

· The Make Stamp command will change the creation time of all selected folders, unless 
some files in the folders are in use by other applications.    If you include any such folders
in your selection and then execute the Make Stamp command, you will receive error 
messages, one for each selected folder with files in use, as the command steps through 
the list.

· The Make Stamp command will change the last modification time even of the read-only, 
system, or hidden files if you include any files with these attributes in your selection.    
Only in the case of read-only files you receive warnings, one for each selected read-only 
file, as the command steps through the list.    You have to confirm your intention to 
change the date and time of each read-only file before the command can proceed.    
Alternately, you can confirm your intention for all selected read-only files or cancel the 
Make Stamp command progress.

· The Make Stamp command is unable to change the last modification time of files 
currently in use by other applications.    If you include any such files in your selection, you
will receive error messages, one for each selected file in use, as the command steps 
through the list.

· When you stamp folders or files with a date ahead of the internal computer clock and 
then run the Norton Disk Doctor (NDD) manually, it reports disk corruption. If you allow 
NDD to fix it, it returns the future folder and file dates back to the present date.    If you 
do not, the NDD reports the same error next time you run it manually.    There is no disk 
corruption; the NDD just assumes that a future folder or file date must be a sign of it.    If 
you temporarily set the internal computer clock ahead of the stamped future dates and 
then run the NDD manually again, no disk corruption error is reported.    In any case, no 
disk corruption error is reported when you stamp folders or files with a date behind the 
internal computer clock, when you stamp with just the time ahead (within the present 
date), or when you run the Norton Disk Doctor automatically as a scheduled task.

· If no files or folders are selected in the  File_List control, the Make Stamp command is 
disabled.



Destroy Files

· When you delete a file by ordinary means, the file entry in the directory is marked invalid
and the disk space occupied by the file becomes available for subsequent file storage.    
However, until you create or copy some files following the delete operation, the deleted 
file is still present on the disk and can be recovered by various undelete utilities.    When 
creating or copying files, the operating system may randomly overwrite some or all 
segments of the previously deleted file, but not necessarily.    The entire deleted file or a 
portion of it may still be present and possible to recover.          

· Use the Destroy Files command to destroy folders or to wipe out files selected in the 
main window  File_List control without trace.    All files in a folder selected for destruction 
and all files in its subfolders are also wiped out without trace and all the subfolders are 
destroyed. 

· WARNING: The files are not just moved to the Recycle Bin or simply deleted. They are 
always completely lost and impossible to recover by various undelete utilities, not even 
segments of these files or their names.

· The Destroy Files command is able to destroy selected folders, unless some files inside 
these folders or their subfolders are in use by other applications.    If you include any such
folders in your selection and then execute the Destroy Files command, you will receive 
error messages, one for each selected folder with files in use, as the command steps 
through the list.    Please note that only the files in use remain intact, while the other files
are still wiped out. 

· The Destroy Files command will wipe out even the read-only, system, or hidden files if 
you include any files with these attributes in your selection.    Only in the case of read-
only files you receive warnings, one for each selected read-only file, as the command 
steps through the list.    You have to confirm your intention to destroy each read-only file 
before the command can proceed.    Alternately, you can confirm your intention for all 
selected read-only files or cancel the Destroy Files command progress.

· The Destroy Files command is unable to wipe out files currently in use by other 
applications.    If you include any such files in your selection, you will receive error 
messages, one for each selected file in use, as the command steps through the list.

· If no files or folders are selected in the  File_List control, the Destroy Files command is 
disabled.



Select All Folders

· The Select All Folders command selects all folders in the current open folder, i.e., folders 
listed in the main window File_List control, for date and time stamping or destruction.

· To clear the selection of all selected folders and files, just press one of the Sort_Buttons.

· If the File_List control is not set to display folders in the File tab page f the Options... 
dialog box, the Select All Folders command is disabled.



Select All Files

· The Select All Files command selects all files in the current open folder, i.e., files listed in 
the main window File_List control, for date and time stamping or destruction.

· To clear the selection of all selected folders and files, just press one of the Sort_Buttons.

· If the File_List control is not set to display files in the File tab page f the Options... dialog 
box, the Select All Files command is disabled.



Options...

· The Options... command (Time tab page of the corresponding dialog box) allows you to 
choose 12- or 24-hour time format.

· You can start the next session of the DateTime File Stamp program either with the 
current date and time or you can keep the last date and time used for stamping folders 
and files, depending on the check mark in the Time tab.    

· DateTime File Stamp program always stamps the files selected in the main window 
File_List control with time rounded to the nearest minute as a minimum time step.    Using
the Time tab page, you can choose hours, days, or even months instead as the minimum
time step.    When selecting hours, the time shown on the main window Date/Time_Stamp
display is rounded to the nearest hour and the minute spin-button becomes disabled.    
When selecting days, the time is rounded to the nearest day and both the minute and 
hour spin-buttons become disabled.    When selecting months, the time is rounded to the 
nearest month and the minute, hour, and day spin-buttons become disabled.      

· The Options... command (File tab page of the corresponding dialog box) allows you to 
show sub-folders only, files only, or both in the main window File_List control, i.e., in the   
current open folder.    Listing of sub-folders helps in navigating through the file system, 
because a mouse double-click on a sub-folder makes it the current open folder. This is 
the preferred way to go one level down in the folder tree on the current drive.

· Using File tab page, you can also direct the DateTime File Stamp program to list or hide 
system, hidden, read-only, or archive files, i.e., files with the system, hidden, read-only, 
or archive file attributes set.    Files with two or more of these attributes are not shown 
unless you include files with each of the corresponding attributes.      

· You can allow all uppercase file and folder names, or you can change them to capitalized 
lowercase names for easier reading, depending on the on the check mark in the File tab. 
Please note that this applies only to the short (8.3) DOS style folder and file names.    File 
and folder names longer that the DOS limit are not affected even if their names are all 
capitals. 

· When using keyboard control, give an input focus to the tab control with the <Tab> key.   
Select the desired tab page with the <Left> and <Right> arrow keys.    Step into the tab 
page with the <PgDn> key and step out of the tab page with the <PgUp> key.



Time Zone....

· The Time Zone command allows you to select the time zone.    Similar capability is 
available in the Windows 95/98 Date/Time Properties, which you can access by double 
clicking on the Windows taskbar clock.    As opposed to this Windows utility, the Time 
Zone command allows you to select the time zone either by its name or by the location, 
where it is used.    The Time zone dialog box also shows the rules for daylight savings for 
the selected time zone. 



Map Net Drive...

· The Map Net Drive command allows you to connect to a drive on the network and map it 
under a new local drive letter.    Similar command is available on the Tools menu Microsoft
Windows Explorer (i.e., file manager) as well.    As opposed to the Windows Explorer, you 
do not have to type in the network path to the drive - you either select the network path 
fro the list of recent network paths (just like in the Windows Explorer) or you browse for it
using the <Browse> button.    You can also clear the list of recent network paths using 
the <Clear All> button.    This option becomes handy if you want to remove non-existent 
network paths after your network configuration was changed.    

· If you do not use the network security (for example, on your home computer network), 
you can leave the user name and password blank.    If the network security is used 
(usually at your workplace), you must provide valid entries for these fields.    Ask your 
network administrator, if you do not have or do not know your user name and password.

· You can make the connection persistent, i.e., Windows will try to connect to the selected 
network drive at the next log-on of the same user (usually at Windows start-up) and 
assign the same local drive letter.

· If no network is present, the Map Net Drive command is disabled.



Remove Net Drive...

· The Remove Net Drive command disconnects from the network drive unless some files 
on this network drive are open or used by an active process on your computer.    In this 
case you receive a warning, which you can override and disconnect anyway.    Similar 
command is available on the Tools menu Microsoft Windows Explorer (i.e., file manager) 
as well.    

· If you are disconnecting from a network drive, whose local drive letter is remembered for
a persistent network connection, you can force Windows to forget this connection.    By 
default, this option is checked if the local drive letter of the selected network drive is 
actually remembered.      

· If no network drives are connected, the Remove Net Drive command is disabled.



Exit

· The Exit command terminates the DateTime File Stamp program. 



Maximum...

· Using the Maximum command, you can set the maximum number of Date/Time stamps 
saved on the Stamps menu to anything between 1 and 25.    Twenty five additional menu 
commands just about fill a video monitor with 800 ´ 600 pixel resolution.

· The Date/Time stamps are added to the bottom of the Stamps menu whenever you 
stamp files or folders using the Make Stamp menu command, unless an identical stamp 
already exists on the menu.    After the maximum allowed number of Date/Time stamps is
reached, the top stamp is simultaneously removed from the menu.

· The Date/Time stamps saved on the the Stamps menu can be divided into groups by 
inserting horizontal lines (separators) in the menu for improved readability.    By default, a
separator is inserted after every fifth stamp.    Using the Maximum command, you can 
choose groups of different size.    Obviously, if the group size is greater than or equal to 
the maximum number of recent stamps, no separators are inserted.



Arrange...

· Using the Arrange command, you can arrange the Date/Time stamps saved on the 
Stamps menu in an ascending order (past dates at the top, future dates at the bottom). 

· The Arrange command also updates the 12- or 24-hour time format of the saved 
Date/Time stamps, depending on the current time format selected in the Time tab of the 
Options dialog box.

· If no more than one recent Date/Time stamp is present on the Stamps menu, the Arrange
command is disabled.



Delete All

· Using the Delete All command, you can delete all Date/Time stamps saved on the 
Stamps menu.

· Individual Date/Time stamps can be removed from the Stamps menu by selecting them 
from the menu while holding down the <Ctrl> key.

· If no recent Date/Time stamps are present on the Stamps menu, the Delete All command
is disabled.



Recent Date/Time Stamps

· Every time you stamp files or folders using the Make Stamp menu command, the current 
Date/Time stamp is saved at the bottom of the Stamps menu, unless an identical stamp 
already exists on the menu.    After the maximum allowed number of Date/Time stamps is
reached, the top stamp is simultaneously removed from the menu.    The maximum is set
by the Maximum menu command.    Recent Date/Time stamps saved on the menu can be
used again later on, without typing the date and time into the Date/Time_Stamp edit 
control or setting them with the help of the corresponding spin-buttons.    Just select the 
desired stamp from the menu to insert it into the edit control.      

· All recent Date/Time stamps can be removed from the Stamps menu using the Delete All 
menu command. Individual stamps can be removed by selecting them from the menu 
while holding down the <Ctrl> key.



Help Contents...

· The Help Contents... command displays context sensitive help window.

· If you press <F1> key or execute the Help Contents... command, help for the main 
window control object with the input focus is displayed.    Change the input focus by 
clicking the control object with the mouse or by pressing the <Tab> key.

· If you press <F1> key while tracking a menu, help on the pulldown menu or on the 
highlighted menu item is displayed.

·  If you press <F1> key while a dialog box is open, help on the dialog box is displayed. 
This help page is identical to the help page associated with the menu item that opens 
the dialog box.

· If none of the above conditions apply, the Help Contents are displayed.



How to Use Help...

· The How to Use Help... command displays general directions on how to use the Windows 
help engine.



Register...

· The Register... command allows to register the present version of the application by 
entering a valid serial number.    The serial number is send to the user upon Registration 
of this software product. After executing the Register command, entering a valid serial 
number, and pressing the <Register> button, the welcome dialog box no longer shows at
the application start-up.      

· The Register... command also allows to unregister the present and all previous versions 
of the application, i.e., to clean-up of all Windows registry entries the DateTime File 
Stamp application made on your computer.    Unregistering is recommended when 
upgrading to the next version or when uninstalling the application completely.    Please 
record the serial number (if you have one) in case you wish to use it to register the next 
version, and then press the <Unregister> button.    The application exits and you can 
manually delete all application files and folders.    If you execute the unregistered 
application after that, it updates the registry entries with default values.    Also, the 
welcome dialog box shows up again until the application is re-registered. 



About...

· The About... command shows the application icon, application name, version number, 
name of the author, and the software development tool.



How to Register

· Unregistered copy of DateTime File Stamp program displays a registration reminder at 
start-up,    otherwise it is fully functional.    Registered users are entitled to receive, at an 
additional cost, the application source code in C++. 

· To register the DateTime software, please send the Order_Form and a check or money 
order to: 

Vladimir Zajic 
29 Milldown Road
Yaphank, NY 11980, USA
E-mail vzajic@mail.bnl.gov 

Payment must be in US dollars.    To print the Order_Form, display it first and then click on
Print Topic in the File menu.    Registered copy of the DateTime software will be sent by E-
mail or shipped on a 1.44 MB 3½" floppy disk.    Please include shipping in the total 
payment only if you wish to receive the disk. 

· A site license for DateTime File Stamp program entitles an organization to receive one 
copy of the software, duplicate it for the specified number of copies, and install it on the 
specified number of computers.



Order Form

            Name: _________________________ Date: ____________
         Company: ____________________________________________
         Address: ____________________________________________
City, State, Zip: ____________________________________________
         Country: ____________________________________________
  E-Mail address: ____________________________________________

DateTime File Stamp software,
Single Copy:            ____ copies         at $19 each = ____
Site License:           ____ add. computers at  $7 each = ____
Source code in C++:*    ____ copies         at $19 each = ____
Shipping by E-mail                                        free
Shipping of 3½" floppy disk by U.S. mail:
                      USA and North America at  $2 each = ____
                   Europe and South America at  $3 each = ____
                                  elsewhere at  $4 each = ____
New York residents add local sales tax                  + ____

                         Total payment                  = ____

*) Only with the purchase of single copy registration






